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ST9 Customer letter
Dear Solid Edge User:
Enclosed you’ll find your copy of the latest Solid Edge release – Solid Edge ST9. This release
continues to fulfill our mission to provide great productivity tools at very affordable prices to help
you design better. Solid Edge ST9 delivers more than 1,100 new customer-driven productivity
enhancements, which are based directly on feedback from working closely with customers like you.
Some highlights include:
•

Cloud-enabled design – on your terms: ST9 can follow wherever you go. Your license can now
be held on the cloud if you wish, which means a simple login to start designing, your personalized
settings are remembered, and any software updates can be installed from the cloud, but of
course only when you choose. And designs can be accessed anywhere with support for popular
cloud services like Dropbox, One Drive or Google Drive.

•

Fast and Flexible 3D Modeling: The user interface was enhanced to be more consistent
with Microsoft Office behavior. Easy-to-access tabs can now be used to switch between
documents. Improved support for high resolution monitors. Several enhancements were added
to improve Synchronous modeling, Assembly in-context design, Drawing View performance
and management, and 3D Printing.

•

Scalable Data Management: We have included Data Management capability out of the box with
Solid Edge ST9, and most importantly of all, with no need for additional IT resources, no SQL,
no databases. Finding files is fast and easy - what better tool to integrate with than Windows
Explorer, something every Microsoft user knows. And the Where Used capability another great
searching tool to measure impact of any changes. The Teamcenter integration for Solid Edge
has many improvements including embedded Active Workspace, a dedicated Teamcenter ribbon
where all tools are easily accessed, improved performance, and many more.

Of course there are hundreds more customer driven enhancements that we expect will be put to great
use by you designing great products. I want to encourage you to upgrade to ST9 and see how
these new features can help you design better. See What's New in ST9 for a complete list of all the
great new features in ST9.
This past April Solid Edge celebrated the 20th anniversary of the initial release of Solid Edge. And
for the past 20 years we have been privileged to have a large and growing community of incredible
users that are willing to partner with us to help us improve Solid Edge. I am excited to continue this
partnership and watch what we can achieve together over the next 20 years!
I also want to invite you to attend Solid Edge University 2016. Join Solid Edge experts, other users
and industry partners as they come together to deliver more than 80 workshops and presentations,
and be among the first to harness the power of Solid Edge ST9. The event will be held in Indianapolis,
Indiana on October 25 – 27. I look forward to this event each year and getting the opportunity to meet
with customers and see what great products you design using Solid Edge. Visit our website today to
register and don’t miss the early-bird special that ends July 31st.
Thanks and Design Better.
Jeff Walker
Director, Solid Edge Development
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What's New in Solid Edge ST9
User interface changes
User interface enhancements
These enhancements were made to the user interface in Solid Edge ST9.
Application menu redesigned
Set your default Start page for Solid Edge
2D printing enhancements (Paper Print tab)
3D printing enhancements (Solid Print tab)
Tabbed document system
Data management for unmanaged documents
New command for sharing Solid Edge files
New command for finding Solid Edge files
Last command used in lists stays on top
New Style Palette for assembly models
Preview swatches for styles
Save face and view style changes
New Academic themes
Cloud-enabled Solid Edge
Support for high resolution monitors
Application menu redesign
The Application menu was redesigned to use the touch-friendly, Microsoft backstage layout and
functionality. This is the same interface that Microsoft uses in its Office products, such as PowerPoint,
Excel, and Word. The backstage is where you manage your files and the data about them—creating,
saving, adding custom file properties and materials, and setting options.
The following enhancements were made:
•

In ST9, the default color scheme is White. Other options are Light Gray, Dark Gray, or Black.
You can change the color scheme using the Application color scheme list on the Helpers
tab in the Solid Edge Options dialog box.
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•

You now can add commands accessible from the Application menu to other areas of the user
interface, such as the command ribbon, the radial menu, or the Quick Access toolbar. To do
this, open the Customize dialog box, and after selecting the Environment to customize, set
Choose commands from:=System Menu.

•

When you select the Application Button, all of the functions that pertain to what you can do
with the active document are displayed as tabbed pages along the left side of the application
window. The commands and options that are available on the backstage pages are based on
the document type and whether it is managed or unmanaged. If there are no documents open,
then the options are more limited.

To

Do this

Display the Application Click the Application Button.
menu, which provides
access to all file-level
functions.
Return to the active
document in the tabbed
document view.

Click this:

Or click a tab on the ribbon, such as the Home tab.
Display a page of
related functions in the

1-4

On the Application menu, hover over or click a tab with an arrow
indicator, for example, Learn, New, Open, and Save As.
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To

Do this

backstage area.
Note
Application menu items without the arrow indicator launch a
command directly, for example, Save, Save All, and Exit Solid
Edge.

Fragment: Solid Edge ST9 Release Notes (topicMap)

1-5

TITLE
SPECIFIED
1:Solid
Edge
Release
Notes
NO NO
TITLE
SPECIFIED
1:Solid
Edge
ST9ST9
Release
Notes

To

Do this

Open the Solid Edge
Options dialog box to
Click the Settings tab.
specify the type of tooltip
you want to see.
Open the Customize
dialog box to customize
the default arrangement
of tools, commands, and
keyboard functions.
Change the Solid Edge
Theme.
Open these frequently
used dialog boxes:
•

Material Table

•

File Properties.

•

Property Manager.

Click the Info tab.

Changes to the Solid Edge startup screen
In conjunction with moving the file-related functions of the Application menu onto the new Microsoft
backstage area, the Solid Edge startup screen was redesigned as a start page that you can change
to meet your current design needs. Now you can choose one of several page or document options to
display when Solid Edge opens, so that you can begin creating or editing faster. The Learn page
(shown below) hosts links to Solid Edge Help and Training. This is the default start page when
you first install Solid Edge.
To change your start page option, go to Application Button→Settings tab→Options
command→Solid Edge Options dialog box→Helpers tab.

1-6
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2D printing enhancements (Paper Print)
The new layout of the Application menu has the advantage of grouping similar functions and making
them visible and available without having to navigate additional menus. The new Paper Print page
on the Application menu contains all of the 2D print commands and related functions for printing
any Solid Edge document to paper or to a file.
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3D printing enhancements (Solid Print)
A new Solid Print page on the Application menu groups the following 3D print-related commands
and other functions that you need to generate a 3D prototype of your part, sheet metal, or assembly
model:
•

Conversion Tolerance option, to control the tessellations on the model.

•

Preview command, to show you the model appearance and extents before it is sent to print
production.

•

Print to File command, for saving the file to STL format.

•

3D Builder command, to send the .stl file to a 3D printer.

Tabbed document system
A new tabbed document interface in all environments lets you view and switch easily between all
of your open document windows simply by clicking a tab. Commands that you previously had to
navigate to on the View tab→Window group are now available directly in the new tabbed interface.
•

Two new context menus are available when you right-click a document tab (1) or the tab list bar
(2). These provide fast access to commands for manipulating document windows, including some
new commands, such as Open Document Folder and Copy Folder Path.

•

When you have many documents open, or when you have the same document open in multiple
windows, you can scroll through the document windows using the right and left arrow controls
(3). You also can use the mouse scroll wheel.

•

You can drag the tabs to change the display order in the tab list bar.

1-8
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Data management for unmanaged documents
A new Data Management tab on the ribbon provides built-in data management tools within
Solid Edge. The commands on the Data Management tab are for those working in a 3D design
environment who do not need the automated processes provided by document management in
SharePoint or Teamcenter.
These basic tools:
•

Provide up-to-date document information.

•

Prevent file and part number duplication.

•

Quickly search for related documents.

•

Find everywhere a file is used.

•

Share, mark up, and revise documents through View and Markup and Design Manager cloud file
services.
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New command for sharing Solid Edge files
A new Pack and Go command
copies and packages a complete set of project documents,
so that you can email them or share them with a customer or vendor. In the Pack and Go dialog
box, you can set options to:
•

Maintain the existing folder structure.

•

Flatten the folder structure.

•

Include additional files, such as simulation results and draft files.

•

Create or overwrite a .zip file.
Example

The command is available on the Application menu→Share tab, as well as in Design Manager.
New command for indexing files for search
To improve the performance of search based on Solid Edge document properties, a new Fast Search
command is available on the Application menu→Settings tab.
The Fast Search command provides Microsoft Windows index-based search within Solid Edge.
Clicking the command displays the new Fast Property Search page (Solid Edge Options dialog
box , which you use to specify the locations of Solid Edge folders and properties that you want to
index for searching. You can index and search your local computer or a network file server.
Fast Search identifies the following types of document properties:
•

Standard Solid Edge properties, for example, document number, revision number, project name,
and document status information.

•

Custom properties defined in your templates and in the propseed.txt file.
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Note
If you are using a file server, first start the installation wizard by selecting the Fast Search
link on the Solid Edge installation screen. This adds two new commands on the Start menu:
Use this Start
menu option
Fast
Search
Configuration

Duplicate File
Report

To do this
Launch the Fast Search Configuration utility (SearchConfig.exe), which
sets up the fast search locations and property locations on a network
file server.
Runs a Solid Edge command line utility (DupFileReport.bat) that
generates an enhanced duplicate file report with a weighted list of
duplicate files by taking into account more Solid Edge file characteristics
than the standard properties.
Additional files related to this utility are delivered in the Solid Edge
Preferences folder.

New way to manage settings and preferences
Using the Settings and Preferences Wizard or the Solid Edge Options dialog box→User Profile
page, you can now easily capture information associated with settings and preferences from one
machine and deploy that information to other machines.
You can capture registry settings, templates stored on a server, themes in the AppData folder, and
customized files located in the Preferences folder.
New Style Palette for assembly models
A new Style Palette is available in the Assembly PathFinder tab set for applying colors to the
model. You can drag materials from the style palette onto parts and features in the assembly model.
The body highlights to indicate that the material color is applied.

Fragment: Solid Edge ST9 Release Notes (topicMap)

1-11

TITLE
SPECIFIED
1:Solid
Edge
Release
Notes
NO NO
TITLE
SPECIFIED
1:Solid
Edge
ST9ST9
Release
Notes

Preview swatches for styles
Preview swatches are now displayed in dialog boxes and on command bars where you select face
styles, fill patterns, hatches, and materials. Previously, color options were listed by name only,
without a graphical preview.
Here are some of the locations where preview swatches are available:
•

1-12

For the Part Painter command, from the Style list on the command bar:
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•

In the Material Table, on the Material Properties tab, from the Face Style list.

•

In the Assembly environment, alongside the Face Overrides command, from the Face Style list
on the ribbon:

•

In the Color Manager dialog box, from the Base Styles lists.

•

For the Styles command, in the Style dialog box, for the following Style types:
Style type

Example

Faces Styles

Fragment: Solid Edge ST9 Release Notes (topicMap)
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Style type

Example

Fill

Hatch

Save face and view style changes
Now you can save changes that you make to the appearance of model faces (such as color, shine,
reflection, texture) and to the 3D view of the model (such as lighting, background, drop shadow).
•

You can save the overrides to the current 3D view style or face style using the Save As button in
the View Overrides dialog box and the Face Overrides dialog box.

•

You can modify the newly created style using the View tab→Style group→Styles command,
and then selecting the appropriate style type.

Part Painter resets Parasolid body color
A new option on the Part Painter command bar enables you to remove all previously applied colors
from model features, faces, and bodies. The Replace styles option applies the default model color to
the entire model, removing all other colors and color overrides.
This option solves the problem of Parasolid bodies in imported or converted models not responding to
color changes applied with Part Painter.
Last command used in lists stays on top
Now you can specify that the last command that you selected from a list on the command ribbon
stays on top as the default command.

1-14
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Example
When this option is selected, the default command, Tangent Arc, is replaced by the
selected command, Arc By Center Point, on the top of the stack.

The new option, Last command used (in droplists) stays on top, is located on the Helpers tab in
the Solid Edge Options dialog box. This option affects all environments.
New Academic Themes
This release has new Academic Themes that can be selected to help simplify the process of learning
Solid Edge for our youngest learners. The themes provide a single-tab interface that contains a
reduced number of tools and commands for each environment that should be sufficient to initially
learn Solid Edge using a simplified interface.
The full-compliment of Solid Edge commands remain available by simply choosing a professional
theme.
These Academic Themes can only be selected by educators and students that are operating on a
Solid Edge Academic License. At this time two new sets of themes have been introduced:
First Steps
This theme is designed to provide a consolidated set of tools and commands onto a single tab
to be used by our youngest modelers as they initially learn Solid Edge. It provides a simplified
interface for learning part, assembly, and draft skills with an emphases on synchronous modeling
techniques.
Next Steps
This theme provides more tools, and commands for young modelers as they tackle more
ambitious synchronous modeling skills.
For more information about themes in general and how you can select and apply themes, see Solid
Edge themes.
Cloud-enabled Solid Edge
A new application, Solid Edge Cloud Gateway, makes it possible to use Solid Edge from multiple
machines. Data can be local or synchronized between desktop and Internet users via Dropbox.
Solid Edge Gateway provides a dashboard, which you use to:
•

Log in using your Webkey account.

•

Get your license to run Solid Edge.

•

Manage individual and group preferences across machines through the cloud.
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•

Download and install Solid Edge product update maintenance packs.

For more information, see the Solid Edge Installation and Licensing Guide.
Support for high-resolution monitors
Solid Edge ST9 has improved support for bitmaps, controls, and other graphic elements displayed
on high-resolution monitors (3K, 4K, and higher). Although high-resolution monitor support is
available for both Microsoft Windows 7 and Windows 10, Windows10 offers superior dots-per-inch
(DPI) scaling capabilities.
When you use a monitor with DPI greater than 170 pixels, we recommend you adjust settings in two
locations:
•

Set the primary DPI scaling resolution for the entire desktop using the Microsoft Windows
Control Panel.

•

Adjust the relative sizing of Solid Edge design tools on the Helpers tab in the Solid Edge
Options dialog box.

Set the Windows screen resolution
From the Microsoft Windows 7 Start menu, go to:
1. Control Panel→Appearance and Personalization→Display.
2. In the left link pane, click Set custom text size (DPI).
3. In the Custom DPI Setting dialog box, choose this:
Scale to this percentage of normal size=200%
Note
The Control Panel location for setting DPI scaling is the same in Windows 10, but additional
options are available.
Adjust the relative size of Solid Edge design tools
If you work with multiple screen resolutions (including 4K), you can choose a larger display size for
the steering wheel, OrientXpres tool, and Quick View Cube control, so that they are easier to work
with on screens of different sizes.
1. In Solid Edge, go to the Application menu→Settings tab→Options command→Helpers tab
(Solid Edge Options dialog box).
2. In the General section, from the Steering Wheel, OrientXpres, and View Cube size list,
choose a size.
From left to right, the size options are Small (0.75 inches), Medium (1.00 inches), Large (1.25
inches), and Extra Large (1.50 inches).
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Part enhancements
Part enhancements
These part modeling and surfacing enhancements were made in Solid Edge ST9.
Material Table enhancements
Multi-body cut enhancements
Multi-body rounding and chamfering
Blocks functionality now available in Ordered Part, Ordered Sheet Metal, and Assembly
environments
Enclosure command now available in Part and Sheet Metal environments
Chamfers maintained during synchronous move, rotate, and dimension edit operations
Ordered body display while working in synchronous mode
New Design Intent rule (Maintain Offset Faces)
Duplicates command (patterning)
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Associative Mirror command in Part
Dimension a hole to a virtual vertex
Pattern by Table command enhancements
Solid swept features
Spiral curves
Material Table enhancements
More usability enhancements were added to the Material Table.
In the Material Table dialog box, these changes include:
•

Materials with out-of-date properties are highlighted. You can use the new command, Update
Material Properties
document.

, to update the material definition in the current part or sheet metal

•

Resizing handles for the dialog box.

•

Sorting the material tree by ascending or descending material names.

•

Listing the items in the material tree by material group, material library, or by material name.

•

Automatic physical property update when you change material properties or gage properties.

•

Image previews of face and fill styles. Direct access to the Styles dialog box for creating mew
face styles and fill styles.

Outside of the Material Table dialog box, these enhancements include:
•

A new option on the General tab (Solid Edge Options dialog box), specifies whether to check
for out-of-date materials and gages when a part document is opened.

•

A new command, Check Out of Date Material
, is available on the Material Table shortcut
menu in PathFinder. It is also available as a button in the Physical Properties Manager dialog
box in an assembly.

•

In PathFinder, an out-of-date status indicator now precedes the material name.

•

Materials that you apply to a model are added automatically to the Variable Table. This enables
you to reference them as custom properties in the File Properties dialog box, and as exposed
variable properties in the Draft environment.

•

When copying and pasting materials, duplicate names are identified. A dialog box offers options
to replace and copy, do not copy, or rename and copy the material.

Multi-body cut enhancements
In multi-body modeling, you can control how a cutout feature interacts with the design bodies it
intersects.

1-18
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(1, 2)
(3)
(4)
(5)

The Apply Cut Features option is only available when the Extrude options are set to:
Extent=Finite (1) and Add/Cut=Cut (2).
Use the Apply Cut Features option on the Extrude command bar.
The Cut Active Body option only cuts the active design body.
The Cut Selected Bodies option cuts all bodies that are intersected by the cut. All
intersected bodies highlight in green. You can deselect an intersected body by pressing
the Ctrl key while selecting the design body.

When the model contains multi-bodies, the Apply Cut Features option is available for the following
commands:
Ordered
•

Cut

•

Revolved Cut

•

Hole

Synchronous
•

Extrude

•

Revolve

•

Hole
Note
For linear cuts, all Extent types are valid except Through Next.

When patterning or mirroring a cut feature that passes through multi-bodies, the pattern maintains the
multi-body selections.
Multi-body rounding and chamfering
You can now create a single round or chamfer feature by selecting edges from different multi-bodies.
Display of ordered bodies while in synchronous mode
There is an Ordered Body display setting so that a transparent representation of the finished model
is shown while in synchronous mode.
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Blocks
•

Blocks are now available in the following environments:
o

Ordered Part

o

Ordered Sheet Metal

o

Assembly layout

Common feature profiles can be added as a block instead of redrawing. Each environment
has access to block libraries.
•

The Open and Edit Blocks commands are not available in these environments. The workaround
is to use the Unblock command, make edits, and then recreate the block.

Enclosure command now available in Part and Sheet Metal
The Enclosure command is now available in the synchronous and ordered Part and Sheet Metal
environments, so you can create a box or cylinder around the selected part geometry.

Each new enclosure adds a new body to the model.
Chamfers maintained during synchronous move, rotate, and dimension edit operations
Chamfers are now recognized and maintained during synchronous move, rotate, and edit operations.
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New Design Intent relationship (Maintain Offset Faces)
A new Design Intent relationship is available, called Maintain Offset Faces (I).
Solid Edge can now detect thin features like ribs, webs, thinwalls etc. in translated models during
sync edits. This new option is used to help you maintain the design intent you build into your parts.

Associative Mirror in synchronous part
The synchronous Mirror command in part now behaves like the synchronous Mirror command in
sheet metal. The part Mirror command now has a Persist option (1) to make the mirror associative
to the parent features.

In PathFinder, the associative mirror feature has a lock icon (2) in front of the feature name. A
non-associative mirror has no lock icon.

Duplicates command
Use the new Duplicates command in the Part and Sheet Metal environments to create duplicate
geometry using blocks and coordinate systems to define the new location. This command can be
used to create a 3D pattern.
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The Duplicates command
is located on the Home tab→Pattern group→Pattern list. The
operation creates a pattern feature which can be edited.
Dimensioning a hole to a virtual vertex
When placing a hole, you can now dimension to a virtual vertex. While in the endpoint mode E
(1), press J to switch to intersection mode (2).

Pattern by Table command enhancements
•

The Pattern by Table command now supports the use of an embedded Excel spreadsheet. A
Link option in the Instance Table dialog box controls whether a linked or embedded Excel
spreadsheet is used to drive the pattern.
After browsing for the Excel spreadsheet, uncheck the Link box to make the selected
spreadsheet embedded in the file.

1-22

Fragment: Solid Edge ST9 Release Notes (topicMap)

Solid Edge ST9 Release Notes

•

You can define a ‘From’ point (Pattern Origin Point) in a separate optional step, so that the
pattern origin can be defined from a keypoint other than the origin of the pattern coordinate
system.

•

You can define a precise point using model keypoints with the ‘To’ point (Parent Reference
Point) in the Instance Table dialog box.

•

The parent instance handle is marked similar to that in synchronous Pattern commands.

Solid swept features
For machine tool operations such as the creation of tines on a drill bit or the well in a barrel cam,
typical cutout features do not suffice to accurately represent the realistic faces of a tooled part.
Now you can model these solid swept extruded features and solid swept cutout features using the
following new commands:
•

Home tab→Solids group→Add list→Solid Sweep Protrusion

.

Example

•

Home tab→Solids group→ Cut list→Solid Sweep Cutout

.
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Example

Spiral curves
Now you can create a 2D spiral curve using the Helical Curve command and the new Spiral option
in the Helical Curve Parameters dialog box.

Sheet metal enhancements
Sheet metal enhancements
These sheet metal enhancements were made in Solid Edge ST9.
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Etch command enhanced
Material Table enhancements
Move and Rotate commands now available in Flat Pattern
PathFinder now indicates clashes in flat patterns
Blocks functionality now available in Ordered Part, Ordered Sheet Metal, and Assembly
environments
Enclosure command now available in Part and Sheet Metal environments
New Design Intent rule (Maintain Offset Faces)
Duplicates command (patterning)
Spiral curves
Etch command enhancements
•

The Etch command now supports the selection of objects across the boundary of a tab. If you
select an object that intersects the tab boundary, the etch extends only to the boundary of the tab.

Fragment: Solid Edge ST9 Release Notes (topicMap)
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If you edit the boundary, the etch automatically adjusts to the change.
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•

The following new options are available in the Save as Flat DXF Options dialog box when
you export the sheet metal file to dxf format:
o

Etch Feature Line Type

o

Etch Color

Two parameters were added to the sesmf.ini file to define the line style and color mapping when
exporting an etch feature as sketch geometry.
o

100=UseEtchFeatureLineType defines the line type.

o

8=Use Etch Feature Color defines the line color.
Note
To include this new functionality in legacy Solid Edge files, you need to add these values
to the sesmf.ini file.

•

Stick fonts are now delivered with the Solid Edge fonts.

Material Table enhancements
More usability enhancements were added to the Material Table.
In the Material Table dialog box, these changes include:
•

Materials with out-of-date properties are highlighted. You can use the new command, Update
Material Properties
document.

, to update the material definition in the current part or sheet metal

•

Resizing handles for the dialog box.

•

Sorting the material tree by ascending or descending material names.

•

Listing the items in the material tree by material group, material library, or by material name.

•

Automatic physical property update when you change material properties or gage properties.

•

Image previews of face and fill styles. Direct access to the Styles dialog box for creating mew
face styles and fill styles.

Outside of the Material Table dialog box, these enhancements include:
•

A new option on the General tab (Solid Edge Options dialog box), specifies whether to check
for out-of-date materials and gages when a part document is opened.

•

, is available on the Material Table shortcut
A new command, Check Out of Date Material
menu in PathFinder. It is also available as a button in the Physical Properties Manager dialog
box in an assembly.

•

In PathFinder, an out-of-date status indicator now precedes the material name.
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•

Materials that you apply to a model are added automatically to the Variable Table. This enables
you to reference them as custom properties in the File Properties dialog box, and as exposed
variable properties in the Draft environment.

•

When copying and pasting materials, duplicate names are identified. A dialog box offers options
to replace and copy, do not copy, or rename and copy the material.

Move and Rotate commands now available in Flat Pattern
The Rotate Face and Move Face commands are now enabled in the Flatten environment. Use these
commands to change the orientation

or position of a flat pattern.

1-28

Fragment: Solid Edge ST9 Release Notes (topicMap)

Solid Edge ST9 Release Notes

Note
The commands only support the Body selection type.

PathFinder now indicates clashes in flat patterns
PathFinder now displays an arrow next to any flattened feature in a flat pattern that contains a clash
between sheet metal tabs.

In addition to the indicator in PathFinder, a warning message indicates the flattened feature contains
overlapping tabs.
Note
The warning is displayed for legacy files when the flatten feature is recomputed in ST9.
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Blocks
•

Blocks are now available in the following environments:
o

Ordered Part

o

Ordered Sheet Metal

o

Assembly layout

Common feature profiles can be added as a block instead of redrawing. Each environment
has access to block libraries.
•

The Open and Edit Blocks commands are not available in these environments. The workaround
is to use the Unblock command, make edits, and then recreate the block.

Enclosure command now available in Part and Sheet Metal
The Enclosure command is now available in the synchronous and ordered Part and Sheet Metal
environments, so you can create a box or cylinder around the selected part geometry.

Each new enclosure adds a new body to the model.
New Design Intent relationship (Maintain Offset Faces)
A new Design Intent relationship is available, called Maintain Offset Faces (I).
Solid Edge can now detect thin features like ribs, webs, thinwalls etc. in translated models during
sync edits. This new option is used to help you maintain the design intent you build into your parts.
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Duplicates command
Use the new Duplicates command in the Part and Sheet Metal environments to create duplicate
geometry using blocks and coordinate systems to define the new location. This command can be
used to create a 3D pattern.
The Duplicates command
is located on the Home tab→Pattern group→Pattern list. The
operation creates a pattern feature which can be edited.
Spiral curves
Now you can create a 2D spiral curve using the Helical Curve command and the new Spiral option
in the Helical Curve Parameters dialog box.
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Assembly enhancements
Assembly enhancements
These enhancements were made in the Assembly environment in Solid Edge ST9.
Blocks
Assembly Relationship Manager
Contour Flange command available in assemblies
Custom occurrence properties in assembly
Duplicate Component command enhancements
Ghost Mode command
Isolate command
Movement of electrical connectors enhanced
Occurrence property enhancements
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Piping enhanced
Replace Face command in assembly
Standard parts enhanced
Subtract command enhancement
Toggle Display command
Thicken command enhancement
Variable Table enhancements
Blocks
•

Blocks are now available in the following environments:
o

Ordered Part

o

Ordered Sheet Metal

o

Assembly layout

Common feature profiles can be added as a block instead of redrawing. Each environment
has access to block libraries.
•

The Open and Edit Blocks commands are not available in these environments. The workaround
is to use the Unblock command, make edits, and then recreate the block.

Assembly Relationship Manager
The Assembly Relationship Manager shortcut command displays a table of assembly relationships
and provides a way to modify relationships. Starting the command with occurrences selected displays
the relationships associated with those occurrences. If no occurrences are selected, the command
shows all of the relationships for the assembly. The relationships are analyzed and displayed. You can
find and repair sick and failed relationships by either suppressing, deleting, or editing the relationships.
Contour Flange command available in assemblies
Now you can use assembly geometry to create a synchronous sheet metal model using the Contour
Flange command
. This enables you to match faces at different angles without having to draw
sketches. You can use this command only if it is the first feature (the base feature) in a sheet metal
body.
To create a sheet metal body in the context of an assembly, first select the Create Part In-Place
to create an empty synchronous sheet metal file. Then you can select the Contour
command
Flange command to locate and select a chain of edges from assembly occurrences to create the
contour flange.
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In the Assembly environment, the Contour Flange command is located on the Home tab→Sheet
Metal group.
Occurrence property enhancements
The following enhancements were made to occurrence properties in assemblies:
•

Two new shortcut commands—Add Override and Remove Override—are available for you to
override the occurrence property values in the context of upper-level assemblies. This means
you can configure your assembly display in reports, draft parts lists, and for placement in other
subassemblies. These value overrides are stored and visible within the assembly where the
change was made. They do not modify lower level documents.
Previously, occurrence properties in read-only subassemblies were not editable in upper-level
assemblies.

•

A new cell color-coding scheme indicates the override status of individual cells in the Occurrence
Properties dialog box.

•

A new option, Save columns setting, is available in the Format Columns dialog box for
occurrence properties. You can save column order and display changes for reuse in other
assemblies by typing a name for the saved settings in the box. Selecting the Save button writes
the settings to a new text file, OccurrencePropertyColumns.xml, in the Solid Edge Preferences
folder.

•

You can define your own custom properties and assign unique values to each occurrence of
user-defined custom properties in parts, subassemblies, and assemblies.
To learn more, see this companion topic in What's New, Custom occurrence properties in
assembly.

Custom occurrence properties in assembly
Custom occurrence properties can now be added to models used in an assembly with the new Add
Custom Occurrence Properties button
in the Occurrence Properties dialog box. Custom
occurrence properties enable you to assign unique metadata to a part or subassembly every time that
part or subassembly is used in the assembly. (System occurrence properties, which provide higher
level information, can only display the same value for each occurrence of the referenced property.)
New custom occurrence properties—BOM ID, Reference ID, Maintenance, and Notes—are defined
as examples in the new CustomOccurrenceProperty.xml file delivered in the Solid Edge ST9
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Preferences folder. You can edit the file to provide a list of selectable values for these custom
occurrence properties or to add your own properties.

Custom occurrence properties are also available in the Draft environment for creating parts lists and
annotating drawing views.
Duplicate Component command enhancements
You now can use the Duplicate Component command
to locate an existing coordinate system
or a block in an assembly sketch to position and orient the components.
Using the Select From and the Select To steps, you can:
•

Select a block in an assembly or subassembly sketch, which is then matched to the orientation
of the components.
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•

Select an existing coordinate system, which is then matched to the coordinate system of the
components.

Movement of electrical connectors enhanced
You can now move electrical connectors which contain wires inside a cable or bundle, which creates
a blue dot. When you move the connector, the wires, along with the cable or bundle, maintain
geometry relative to the connector.
Isolate command
Use the Isolate command
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on the Select shortcut menu to display only the selected parts.
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In the graphic window, click the Restore button (1) to return to the pre-isolate view or click the
Dismiss button (2) to keep the isolated view.

Toggle Display command
You can use the Toggle Display button
on the status bar to toggle the display status of all
components. Hidden compents display as transparent, but visible for easy selection. This is useful
for displaying hidden parts without the use of PathFinder.
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For more information, see Toggle the display status of assembly components.
Piping enhanced
Enhancements made to the XpresRoute Piping application include:
•

A new Saved Settings option on the Piping Options dialog box lists saved pipe settings, such
as pipe size, standard, class, and end treatment. You can access the saved settings by selecting
them from the list. The settings on the dialog box display the characteristics of the pipe you select.

•

A new Select preferred class fitting option displays the Standard Parts dialog box so you can
select a preferred fitting from the available fittings in the Standard Parts Library. If there are
multiple fittings available, the fittings appear in a list and you can chose the fitting you want.

•

Several enhancements were made to the Companion option.

•

1-38

o

When you place a flanged fitting or replace a non-flanged fitting with a flanged fitting from
the Standard Parts Library, the Companion Flanges dialog box appears so you can select
the companion flange you want to place.

o

When you replace a flanged fitting with a non-flanged fitting, any companion flanges
associated with the flanged fitting are automatically removed.

o

After you place a companion flange, you can select the flange and replace it with another
companion flange.

o

You can now use the Orientation option on the Piping command bar to rotate a companion
flange.

A new WT (wall thickness) parameter for piping parts in Standard Parts provides a more accurate
list of fittings for a selected pipe size.
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Replace Face command available in assemblies
The synchronous Replace Face command
is now available in assemblies. In the following
example, you can use this command to replace the face where the bolts extend beyond the part. First,
select all occurrences of the bolt faces(1), and then select the single face that is the replacement (2).

In the Assembly environment, the Replace Face command is located on the Features tab→Modify
group. You do not need to be in-place activated to use it.
Standard Parts enhanced
Several enhancements have been made to Standard Parts:
•

The Standard Parts Installation Guide is now available prior to installation in the Standard Parts
setup folder on the DVD.

•

While installing the Piping and Machinery library, during the Custom Setup step, the default
installation location is the last used installation location.

•

While installing the Piping and Machinery libraries, you have the option to automatically add the
parts in the libraries to the database.

•

During the Custom Setup step, there is now an option to deselect all features and subfeatures.

•

During the Custom Setup step, the selection of default standards, such as ANSI or DIN, is
based on the locale of the machine on which Standard Parts Administrator, Machinery library,
and Piping library are being installed.

•

While installing the new standard parts, for example ST9, and there are already existing standard
parts on the machine or the server, during the Custom Setup step, the This feature will not
be available option is turned on.
If there is an existing standard part configuration defined in the registry the This feature will not
be available is turned on by default.

•

During the Custom Setup step of Standard Parts Administrator, you can select the standards,
just as you would when installing the Piping or Machinery libraries.

Fragment: Solid Edge ST9 Release Notes (topicMap)

1-39

TITLE
SPECIFIED
1:Solid
Edge
Release
Notes
NO NO
TITLE
SPECIFIED
1:Solid
Edge
ST9ST9
Release
Notes

•

Beginning in ST9, Solid Edge no longer supports Microsoft Access as a database for Standard
Parts. Solid Edge now delivers SQL Express 2012 with Standard Parts installation.

•

A series of eight new videos show you how to use Standard Parts.
Note
To find a list of videos and interactive simulations that are new in ST9 or were recently
updated, see the help topic, Solid Edge videos.

Subtract command available in assemblies
In an assembly, you now can use the synchronous Subtract command
with the Recognize
Holes option to recognize holes in part files. For example, cylindrical cutouts created with the
Subtract command in the part file, and threaded and clearance holes that were created with the Hole
command in a part file, can now be used to create corresponding holes in another part in the assembly.

Thicken command available in assemblies
You now can use the Thicken command
within the assembly.

to create a new part from faces of an adjacent part

In the context of an assembly, first select the Create Part In-Place command
to create an empty
part file. Then you can select the Home tab→Solids group→Add list→Thicken command to:
•

Locate and select faces from occurrences.

•

Include, exclude, or thicken internal face loops selected from the face.

•

Create a new part in Assembly PathFinder from the thickened faces.
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Variable Table enhancements
More usability enhancements were added to the Variable Table. In the Variable Table dialog box,
these changes include:
•

New Structured View
option—Lists the variables under its parent feature. The tree is
displayed in the Structure column.

•

New List View
option—Shows a flat list similar to the existing view. The Structure column
lists the feature to which the variable is attached.

•

New sorting options include ascending, descending, custom sorting,and multi-level structured
sorting by type and parents.

•

New functions in the Math&Trig category, such as ASIN, ACOS, ATAN, SINH, COSH, TANH,
PI(), E(), PHI(), RADIAN() and DEGREE().

•

Variables selected for exposure using the Expose column and the Exposed Variables column
are now available for downstream use. This ensures that their real values can be referenced in
property text. For more information, see Using exposed variables in property text.

Sketching enhancements
Sketching enhancements
These enhancements were made to sketching in Solid Edge ST9.
New command: Create As Construction
Construction command now has a command bar with a Chain select option.
New command: 3D Point
Stick fonts for etching
New sketch display options
Show Annotations command
Type title text here. Use link tag.
Type title text here. Use link tag.
Create as Construction command
There is a new command called Create as Construction located in the Draw group. This command
changes the sketch creation mode from profile to construction. When the button is on, you are in
construction mode. When the button is off, you are in profile mode.
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Construction command bar
The Construction command now has a command bar which provides the selection options, Single
and Chain. Previuosly, only the Single option and fence selection were available. The new Chain
option selects a connected chain of sketch elements to change between construction and profile.
3D Point command
A 3D Point command was added to the 3D sketching tab.
You place 3D points by:
•

Clicking in 3D space.

•

Selecting a geometric keypoint.

•

Entering an XYZ coordinate on the command bar. The coordinates are relative to the selected
coordinate system.

•

Locking to a coordinate system plane and entering planar coordinates on the command bar. The
coordinates are relative to the selected coordinate system.

Stick fonts
Stick fonts are now delivered with Solid Edge fonts. These fonts provide the optimal solution for
text etching in sheel metal.
Two new options support stick fonts:
•

Show only stick fonts in the list displays the available fonts in the Text dialog box when you
select the Text Profile command.

•

Export Etch text as geometry creates an etch feature when you save the sheet metal part as a
flat pattern in the Save As Flat DXF Options dialog box.

New ordered sketch display options
In some modeling scenarios, the number of sketch elements, colors, styles, and annotations can be
rather significant. This may be the case when using blocks in the design. You may need a method of
controlling the display of these sketches.
In the ordered environment, the sketch display can be controlled with the following new options
found on the Sketch short cut menu:
•

Single color sketch display

•

Multi-color sketch display

•

Accelerated sketch display

•

Show Annotations (also available in synchronous environment)

1-42

Fragment: Solid Edge ST9 Release Notes (topicMap)

Solid Edge ST9 Release Notes

Show Annotations command
The Show Annotations command is located on the shortcut menu of a sketch selected in
PathFinder. This setting turns on or off the display of annotations, such as callouts and block labels,
contained in the sketch. In the ordered environment, the annotations display while in sketch mode.
Note
If Accelerated Sketch Display is on, annotations do not display, even if Show Annotations
is on.

Draft enhancements
Draft enhancements
The following enhancements were made in the Draft environment in Solid Edge ST9.
Associative break lines in broken views
Change drawing view orientation
Change properties on multiple drawing views simultaneously
Change the font size of table cells using direct edit
Count each subassembly occurrence in all parts lists
Edit a section view to change its type
Faster updates for large drawings
Hole callouts now show hole count
Image resolution option for Compare Drawings
Initial dimension stack distance
List all image file types for insertion
New block connector shape type: Gap
New command: Delete Empty Layers
New command: Replace Background
New command: Tolerance Table
Retrieve Dimensions enhancement
Retrieve properties from the parent assembly
Shared saved settings for annotations
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Short list when creating drawing views independent of assembly
Surface texture symbol shelf line
Symmetric diameter dimension enhancements
Text edit shortcut menu
Value formatting for exposed variables used in property text
Value formatting in table columns
Associative break lines for broken views
Now you can associate break lines with drawing view geometry. This ensures that when the model
depicted in the drawing view changes, the broken portion of the drawing view changes along with it.
When creating or modifying a broken view, you can constrain the break lines by snapping to keypoints
on the drawing view geometry.

Change drawing view orientation
Now you can change the orientation of a drawing view after it is created. When you change the
view orientation of a principal view, the orthographic drawing views that are aligned with it react by
changing their orientation.
Previously, you had to delete the drawing view and then regenerate it to change its orientation.
The following options are now available on the command bar when you select a drawing view:
•

View Orientation

•

Drawing View Layout

These options are not available for derived views, PMI model views, views with applied configurations,
and 2D views.
Change the font size of table cells with direct edit
Now you can change the font size of table data using the orange edit frame that appears when you
double-click a table. You can change the font size of data in one or more columns, or for all data
cells in the table.
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Previously, you could only change the font size of the text in the title rows using direct edit.
Change properties on multiple drawing views simultaneously
Now you can change the properties of multiple drawing views at the same time using the Drawing
View Properties dialog box. When you select the Apply button in the dialog box, the changes
are applied to all of the selected drawing views.
The drawing views that you select before you select the Properties command determine which tabs
are displayed, as well as which options on those tabs are available for making changes.
Previously, only the General tab was displayed when you selected more than one drawing view.
Count all occurrences in all parts lists
When you assign a user-defined value to the Quantity occurrence property for a subassembly in
the Occurrence Properties dialog box, the quantity override is now applied to the subassembly,
as well as to all part and component occurrences, in top-level and atomic parts lists. The following
information is calculated and shown in the parts list Quantity column:
•

Total subassembly quantity

•

Total part quantity

There is no additional interface option that you select for this calculation when you generate either a
top-level or atomic parts lists.
Note
This is the same calculation method that was previously only available for exploded parts
lists. For exploded parts lists, you must select the option, Multiply by subassembly count,
on the List Control tab in the Parts List Properties dialog box. For top-level and atomic
parts lists, it is the default calculation method that is used.
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Edit a section view to change its type
Now you can select a section view and change it to a different type of section view without having
to recreate the view.
Example
•

You can select a simple section view and convert it to a thin-section (paper-thin section)
view using the Section Only button on the command bar.

•

You also can convert a simple section view to a revolved section view using the
Revolved Section View button

on the command bar.

Previously, these buttons were only available during section view creation.
Exposed variables referenced by property text
Variables that are exposed in the Variable Table are now available directly as properties in parts lists,
tables, and annotations, bypassing the Custom tab in the File Properties dialog box.
This means you can:
•

Reference the real value of an exposed variable. Previously, exposed variable values were only
available as text strings, not as real numbers, in draft, sketch, and PMI.

•

Format the extracted value using the Format Values dialog box. For example, you can specify
precision, no units, dual units, and tolerance.
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•

Choose the source of the property that you want to use on the Columns tab in the Parts List
Properties dialog box and in the Select Property Text dialog box.
Example
Custom file properties that are listed with the same name also indicate their source.
Accuracy (Custom Property)
Source=Custom tab, File Properties dialog box
Accuracy (Exposed Variable)
Source=Variable Table

This enhancement introduces a new property text output modifier, /EV (exposed variable). This
information was added to the table in Format codes to modify reference and property text output.
Note
These changes do not affect previous property text workflows. You still can reference
exposed variables on the Custom tab in the File Properties dialog box.

Faster update for large drawings
Multi-core processing to support faster updates of drawing views of very large assemblies is available
in ST9. You can turn multi-core processing on and off using the new option, Enable multi-core
drawing view processing, which is located on the General tab in the Solid Edge Options dialog
box.
Hole callouts now show hole count
Now you can show the hole count as well as the hole type in hole callouts, feature callout dimensions,
and dimension prefixes in draft, sketch, and PMI. Eligible hole features are those created with the
Hole command in synchronous and ordered part models, and hole features created in an imported
body using the Recognize Holes command. For assembly models, holes in parts are counted,
as well as assembly hole features placed on a part. Hole count is based on hole type, location,
orientation, and parameters defined in the Hole Options dialog box.
When you select a hole callout, the holes it references are highlighted.
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The hole count is supported by four new property text codes (%QN, %QC, %QA, and %QP). For
more information, see Property text codes.
•

You can select and insert the property text codes using the Select Symbols and Values dialog
box.

•

You can reference the property text codes in the Modify Dimension Style dialog box, the
Dimension Prefix dialog box, and the Callout Properties dialog box.
Note
To use the new hole count codes with legacy draft files, you must force the drawing views to
update using Ctrl+Shift+Update Views command.

Image resolution option for comparing drawings
A new Smoothness slider was added to the Compare Drawings dialog box to control the image
resolution of the output file.
Initial dimension stack distance
A new option, Initial stack distance, is available on the Lines and Coordinate tab (Dimension Style
and Dimension Properties) to specify a unique distance between the innermost dimension in a
dimension stack and the dimensioned geometry. This option applies to linear, angular, symmetric
diameter, concentric diameter, and other stacked dimensions that are arranged automatically.
The new option works with the Stack pitch option, which controls the distance between all
dimensions in the dimension stack.
The following commands use the Stack pitch and Initial stack distance values from the active
Dimension style:
•

Arrange Dimensions (in draft and sketch)

•

Retrieve Dimensions (in draft)

•

Auto-Dimension (in draft and sketch)
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New connector shape type: Gap
When using the Connector command, a new Gap shape (1) is available to show how two connectors
cross. Previously, only a Jump shape (2) was available.

For more information, see Connector command bar.
List all image file types for insertion
When browsing for an image file to insert into a draft or model document using the
Insert Image command
, you now can set the Files of type list to All Image Files
(*bmp,*.png,*.jpg,*.jpeg,*.jpe,*,tif,*.tiff).
This is useful if you do not know the file type of the image you are trying to locate.
New command: Delete Empty Layers
A new command, Delete Empty Layers
, deletes all layers that are not associated with any
geometry. This command is available on the Layers tab in the 2D and 3D environments.
Example
When you migrate AutoCAD files to a Solid Edge Draft document, the original files tend to
have many layers in them. You can use the Delete Empty Layers command to remove
the layers that have no contents.
For more information, see the help topic, Delete one or more layers.
New command: Replace Background
You can use the new Replace Background command
to copy the contents from one or more
background sheets in one draft document to another draft document. The command is available on
the shortcut menu of a selected background sheet tab.
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For more information, see Replace Background command.
New command: Tolerance Table
A new command, Tolerance Table
, generates a table that lists the values and tolerances from fit
dimensions on the active sheet, in selected drawing views, or in a selection set. Eligible fit dimensions
are those with Dimension Type=Class

on the command bar for the dimension.

The Home tab→Tables group→Tolerance Table command is available in the Draft environment, as
well as on the 2D Model sheet and in Solid Edge 2D Drafting.
For more information, see the help topic, Tolerance tables.
Retrieve dimensions into multiple views
Now you can use the Retrieve Dimensions command to retrieve linear dimensions into multiple
drawing views, even when doing so produces duplicate dimensions. You can select the new
command bar option, Multiple Views

, before you select the drawing views.

When this option is deselected, linear dimensions are retrieved once per view, and only when the
view is parallel with the dimension plane.
For more information, see the Retrieve Dimensions command.
Retrieve properties from the parent assembly
When placing annotations, you now can retrieve property values from an assembly or subassembly
that is the immediate parent of a part. Previously, you could only retrieve values from the top-level
assembly, subassembly, or part.
You can select the new option, From graphic connection to assembly, from the Source list in the
Select Property Text dialog box. You also can type the property text code, |GA, in a property text
string to modify the output.
Short list when creating independent assembly drawing views
In ST9, when the Create drawing view independent of assembly option is selected in the Select
Attachment dialog box, the list of parts is shortened to show only one occurrence of each unique
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component at each level. In a large assembly, this makes it faster and easier to navigate the list of
parts. This option is a preference that is remembered between sessions.
Show custom occurrence properties in draft
Custom occurrence properties that are added to an assembly model in the Occurrence Properties
dialog box are now available in the Draft environment for use in parts lists and callouts.
With the introduction of occurrence properties in the assembly, each occurrence of a part model
used in an assembly can have a different value for a property. This is called a custom occurrence
property. Previously, all occurrences of a part model in a parts list displayed the same value for a
referenced property.
You can use custom occurrence properties:
•

In a parts list, to show the different occurrence property values for a part within a single cell.

•

In balloons and callouts, to show the unique occurrence property value of a part in a drawing view.

You can add custom occurrence properties by selecting them from the Properties list:
•

On the Columns tab in the Parts List Properties dialog box.

•

In the Select Property Text dialog box.

Look for the text (Occurrence Property) appended to the property name.
Example
Maintenance (Occurrence Property)
Paint (Occurrence Property)
For more information, see Example: Show custom occurrence properties in a parts list.
This enhancement introduces a new property text output modifier, /OP (occurrence property). This
information was added to the table in Format codes to modify reference and property text output.
Surface texture symbol shelf line
In the dimension style, you can specify the length of the shelf line that appears over or under the text
in a surface texture symbol annotation. The new property, Symbol overline extension, is located on
the Annotation tab in the Dimension Style dialog box. When the Font is set to Italic, you can use
this option to ensure that the line extends the full length of the annotation text.
The value that you enter is multiplied by the font size. In the first surface texture symbol shown below,
the length of the line is the default value, 0.0.
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Symmetric diameter dimension enhancements

Many enhancements were made to the Symmetric Diameter command

•

.

Improved workflow—It is faster and easier to place symmetric diameter dimensions.
o

When you identify the center axis for originating the measurements, it is shown in the
highlight color.

o

Before placing the first dimension, you can press Alt to change the alignment by 90 degrees,
or you can press Shift to locate two points.

o

After placing the first dimension, additional dimensions are placed with a single click on the
next geometric element to measure.

•

Symmetric diameter dimensions are stacked, aligned, and spaced automatically during
placement and when new dimensions are added to the stack.

•

In draft, you can place symmetric diameter dimensions between drawing views.

•

You can place 2D and 3D PMI symmetric diameter dimensions using intersection points.
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•

•

New formatting options are available for symmetric diameter dimensions:
o

Alternate text positions—Makes dimensions easier to read by alternating the position
of dimension text in stacked and grouped symmetric diameter dimensions. This option is
located on the Lines and Coordinate tab (Dimension Style and Dimension Properties).

o

Underline symbol and prefix—Specifies that the dimension line for the symmetric diameter
dimension extends under all of the dimension text. This option is located on the Lines and
Coordinate tab.

o

Suppress symmetric diameter—Prevents the diameter symbol from displaying. This option
is located on the Terminator and Symbol tab (Dimension Style and Dimension Properties).

Symmetric diameter dimensions are created in alignment groups. This means you can:
o

Drag any dimension in the alignment group, and all of the dimensions in the stack adjust
along with it.

o

Alt+drag a single dimension in the alignment group to move it independently of the others in
the group.

o

Use Shift+drag to adjust the spacing between two dimensions.

o

Use the following commands to manage the membership of dimensions in the dimension
alignment group:
■

Remove from Alignment Set

■

Break Alignment Set

■

Split Alignment Set

For more information, see the help topic, Place symmetric diameter dimensions.
Shared saved settings for annotations
Enhancements were made to saved settings for annotations and dimension text in draft, sketch,
and for PMI.
•

Saved settings are now available for the following types of objects:
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•

o

Balloons—Saves properties for Balloon height, Balloon shape, Number of sides, Upper,
Prefix, Lower, Suffix, Orientation, and Text alignment.

o

Edge condition symbols—Saves properties for Direction tolerance 1, Upper tolerance,
Lower tolerance, Direction tolerance 2, No text on symbol, and All around symbol
with leader. Saved settings for edge condition symbols are available for both the Current
ISO/DIN and the Previous ISO/DIN drawing standards.

o

Dimension prefixes—Saves properties for Superfix, Prefix, Suffix, Subfix, Subfix 2, and
Subfix horizontal alignment.

Annotation saved settings are saved to individual text files, so that they can be shared
with other users. These text files are located n the ..\Program Files\Solid Edge
ST9\Template\Reports folder. They are named for the annotation type, for example,
DraftBalloon.txt, DimensionPrefix.txt, and DraftEdgeCondition.txt.
Note
All annotation saved settings are now saved to external files, so that they can be shared
with other users. Before Solid Edge ST9, the saved settings for feature control frames and
surface texture symbols only existed in the document where they were saved. For more
information about these previously saved settings, see Working with *legacy annotation
saved settings.

Text edit shortcut menu
A shortcut menu with the following commands is available in dialog boxes where you can enter
and edit text:
•

Undo

•

Cut

•

Copy

•

Paste

•

Delete

•

Select All

This shortcut menu is available in text fields in Properties dialog boxes. For example:
•

On the General tab, when modifying callout text, technical requirements text, and edge
condition text.

•

On the Title tab, when modifying table titles.

•

On the Caption tab, when modifying drawing view captions.
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Value formatting in table data columns
Now you can format property text values displayed in table columns using the Format Values dialog
box. Previously, only property text in table titles could be formatted.
You can specify the following types of formatting for the resolved values of property text in table
data cells:
•

Precision, no units, or dual units for real number values.

•

Day, date, and time format for date values.

•

Text case for text values.

You can open the Format Values dialog box using the Format button on the Columns tab in the
Properties dialog box for the selected table.
Example

You also can type the format codes to modify reference and property text output directly into the
Property text box for the column definition.
Column data value formatting is available in all tables except hole tables and family of parts tables.

Document management enhancements
Document management enhancements
Document management enhancements and new features included in Solid Edge ST9 are:
Solid Edge Embedded Client
Software compatibility
Teamcenter Preferences
Updated user interface
New File Properties dialog box
Improved Open dialog box
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Updated User Session information
Open multiple revisions
Start a workflow process
Lists of Values (LOV) with descriptions
Support for external collaboration
Sort in Cache Assistant
Enhanced support for Active Workspace
Sort in Cache Assistant
Enhancements to item type list order
Updated data preparation tools
New Where Used options
Structure Editor–Teamcenter
Structure Editor standalone installation discontinued
Sort indented lists
Scroll Lock command removed
Updated User Session information
Access to Managed page of Solid Edge Options
Add to Teamcenter-Interactive
Sort indented lists
Support for naming rules
Updated User Session information
Access to Managed page of Solid Edge Options
Insight
Insight software compatibility
Insight standalone installation discontinued
Sort in Cache Assistant
Updated data preparation tools
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Solid Edge SP
Updated data preparation tools
Faster delete performance
Retaining signoff information
Enhanced Solid Edge SP Feature Library
New way to view draft and PDF information
Improved overall Solid Edge SP usability
View and Markup and Revision Manager
Where's Revision Manager?
Solid Edge Embedded Client
Software Compatibility
Solid Edge Embedded Client ST9 is compatible with the following:
Solid Edge

Teamcenter Rapid
Teamcenter 10.1
Start
10.1.5.1
10.1.5.1

Teamcenter 11.2
11.2.1

ST9
11.2.1
AW 3.1
AW 3.1
Teamcenter Rapid Start replaces Teamcenter Express starting with release 10.1.
Teamcenter 11.2 adds UTF-8 support for Windows (encoding used between
TcServer - Database).
Solid Edge ST8MP2 is certified with Teamcenter 11.2 for production use.
Active Workspace (AW) 3.1 is compatible with 10.1.5/11.2.1 with reduced
functionality. Use 10.1.6/11.2.2 for full functionality.
Solid Edge Embedded Client ST9 does not support:
•

Teamcenter 8.x, 9.x, 10.0, 11.1
Solid Edge ST8 was the last release supporting Teamcenter 9.1

•

Any Teamcenter release prior to 8.x.

•

Teamcenter Express

Teamcenter preferences
New Teamcenter preferences introduced with this release:
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ActiveWorkspaceHosting.SEEC.URL
Specifies the URL used by Solid Edge when hosting an Active Workspace client. This preference
is evaluated prior to the ActiveWorkspaceHosting.URL preference.
AWC_SEEC_OpenSupportedTypes
Enables the specified object types to be opened in Solid Edge when selected in Active
Workspace. Only Item, Item Revision, subtypes of Item and Item Revisions, and Solid Edge
Dataset types are supported.
SEEC_BOM_Precision_Override
Specifies the BOM precision used during the creation of a new Solid Edge Assembly. Valid
values are 0, 1, or 2. Set to 0 to use the same setting as Teamcenter Rich Client. Set to 1 to
override to Imprecise. Set to 2 to override to Precise. Default is 0.
SEEC_Enable_CreatePackage
When set to True (1), adds Create Package command to Solid Edge Cache Assistant toolbar.
Default is 0.
SEEC_Enable_MultipleRevisions
When set to True (1), Solid Edge works with multiple revisions in a single Solid Edge session.
Default is 0.
SEEC_Enable_AssemblyConstructions
Determines if an assembly occurrence marked as a construction is added to the Teamcenter
BOM View Revision. When all occurrences are marked as constructions, the Item Revision is
connected to the assembly using a relation.
SEEC_Item_Type_Sort
Determines the order in which item types are listed in common property dialog boxes. Set to 0
to use the order defined by each SEEC_ItemType preference. Set to 1 to build a hierarchical
and sorted list. Default is 1.
SEEC_ItemTypeList_ExcludedTypes
When a SEEC_ItemTypeList preference is equal to All, item types listed by this preference are
removed. When a new document is saved to Teamcenter, the resulting subset of Item types is
available to you.
For additional information, see the Teamcenter Preferences section of the Teamenter Integration for
Solid Edge Guide for Users and Administrators.
Updated user interface
The user interface for Solid Edge Embedded Client is updated to provide direct and easy access to
commands and enhance your user experience. Updates include:
•

1-58

Teamcenter tab on the Solid Edge command ribbon to collect all Teamcenter commands in a
single location.

Fragment: Solid Edge ST9 Release Notes (topicMap)

Solid Edge ST9 Release Notes

•

Completely revamped and interactive File Properties (SEEC) dialog box.

•

User Session Information that displays as a docking pane to provide you easy access to details
regarding your connection to Teamcenter.

•

Updated Cache Assistant that includes a ribbon of commands.

•

Updated common property dialog boxes such as New Document and Upload Document, that
include commands in a ribbon, plus the commands to hide columns and display required
properties vertically.

•

Improved Open dialog box.

New File Properties dialog box
The File Properties dialog box is updated and greatly enhanced with new functionality.
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The new dialog box:
•

Is interactive and integrated with Teamcenter.

•

Displays Solid Edge file properties in a vertical format.

•

Organizes properties in groups.

•

Respects the preference that determines the use of displayable or real names.

•

Integrates Teamcenter List of Values.

•

Enables you to print the contents or copy the contents to your clipboard.
Note
Accessing the enhanced File Properties dialog box requires that you have a document
open in the Teamcenter managed environment.

For more information, see the help topic, File Properties (SEEC) dialog box.
Improved Open dialog box
The updated Open dialog box contains:
•

A command ribbon.

•

Improved layout, including enhanced presentation of property data.
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•

An Item ID text box that quickly queries for an Item ID without having to use the Advanced
Search command.

•

Overrides for load options.

For more information, see the help topics, Open File dialog box (SEEC) and Quickly search for
an Item ID.
Updated User Session information
User session information is now easier to obtain than ever before.
•

You can log in to Teamcenter and access User Session information from the Solid Edge start
page.

•

Once you are connected to Teamcenter, your current cache workspace is displayed.

•

You can access and change user settings any time a document is checked out to you.

For more information, see the help topic, User Session Information.
Open multiple revisions
You can now open multiple revisions of a document in the same Solid Edge session. This new
capability:
•

Helps facilitate design reviews.

•

Enables designers to view different revisions of a document in separate windows.

Additional information is available in the help topic, Using multiple revisions of documents.
The Teamcenter preference that enables multiple revision support,
SEEC_Enable_MultipleRevisions, is described in the Teamcenter Integration for Solid Edge
Guide for Users and Administrators.
Start a workflow process
You can initiate a Teamcenter workflow from within Solid Edge. Workflows pass documents,
information and tasks between participants during the course of a particular process. The New
Workflow Process command:
•

Allows you to choose the item revisions to be targets of the workflow process.

•

Submits the targets to a single workflow.

•

Processes exceptions and presents corrective action.

The New Workflow Process command is available from:
•

Application menu→Manage.

•

The Teamcenter ribbon.

•

A shortcut command in PathFinder in the assembly environment.

Fragment: Solid Edge ST9 Release Notes (topicMap)

1-61

TITLE
SPECIFIED
1:Solid
Edge
Release
Notes
NO NO
TITLE
SPECIFIED
1:Solid
Edge
ST9ST9
Release
Notes

For more information, see the help topic, New Workflow Process command.
Lists of Values (LOV) with descriptions
You can now integrate descriptions with Lists of Values so that a row in the list includes both the value
and its corresponding description. There is no need to map a separate property to contain the
description. Use this capability to assist users who could benefit from a description to choose an
appropriate value from a list.
This new capability is implemented for the following LOV types:
•

Exhaustive

•

Suggestive

•

Cascading or Hierarchical

•

LOV with Property Dependent Attachment

•

Interdependent LOVs

This capability is also enabled for Structure Editor - Teamcenter and Add to Teamcenter - Interactive.
Additional information is available in the help topic, Lists of Values (LOV). Teamcenter preferences
that influence Lists of Values are described in the Teamenter Integration for Solid Edge Guide for
Users and Administrators.
Support for external collaboration
The Create Package command in Cache Assistant gives you the functionality to create a package of
data to send to design partners and then reintegrate the data into Teamcenter once the collaboration
is complete. Using the Create Package command, you can:
•

Create an unmanaged copy for archival.

•

Create an unmanaged copy for a collaboration partner who performs work and then returns
the data.

•

Populate a workspace so that the data can be used offline. For example, during a design review.

For more information, see the help topic, Create a package of the cache workspace.
Enhanced support for Active Workspace
Use Active Workspace for change management, workflow, requirements management, and
visualization to help you accomplish your tasks. Solid Edge ST9 supports two integrations of Active
Workspace:
•

Hosted Active Workspace
After you start Solid Edge and log into Teamcenter, access the integrated Teamcenter client,
Active Workspace, through a docking pane.
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•

Standalone Active Workspace
Accessed through a browser window where you log into Active Workspace, find Solid Edge data
that is managed by Teamcenter, and send the document directly to Solid Edge.
You can select an Item, Item Revision, or Solid Edge dataset, and then click Open in Solid Edge,
to open the associated design data in Solid Edge.

Both instances support Active Workspace 3.1 which provides the capability to:
•

Select multiple documents for opening.

•

Open a configured structure.

•

Drag and drop to the Solid Edge graphics window.

•

Use the Add Component command to add the selected model to the active assembly.

Additional information is available in Active Workspace in Solid Edge. Teamcenter preferences are
described in the Teamenter Integration for Solid Edge Guide for Users and Administrators.
Sort in Cache Assistant
Cache Assistant now supports multi-column sorting. Using the shortcut command, Sort, you can
select a column and sort the contents:
•

In ascending order, where the lowest number or beginning of the alphabet appears first in the
sorted list.

•

In descending order, where the highest number or end of the alphabet appears first in the
sorted list.

•

In alphabetic and numeric order, so that data containing alphabetical letters mixed with numbers
is sorted logically.
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Example
1
1a
2
2a
2b
•

Alphabetically, where the beginning of the alphabet appears first in the sorted list.
Note
When a column has repeating values for rows, you can select additional columns for sorting
values. Shift+double-click subsequent column headers to add columns as additional
sort columns.

For more information, see the help topic, Sort multiple columns.
Enhancements to item type list order
Teamcenter administrators can take advantage of two new enhancements to item type list order.
Now you can:
•

Determine the order in which item types are listed in common property dialog boxes. The order is
per document type and is defined by the Teamcenter preference SEEC_Item_Type_Sort.

•

Add descriptive or helper text to item type lists when you define the Teamcenter preference
SEEC_Item_Type_Sort. Descriptive information that displays in the item type lists is for display
only and cannot be selected.

This new functionality applies to Solid Edge Embedded Client, Structure Editor, and Add to
Teamcenter-Interactive.
Additional information is available in Set the display order in item type lists and Enter descriptive
information into item type lists. Teamcenter preferences are described in the Teamenter Integration
for Solid Edge Guide for Users and Administrators.
Updated data preparation tools
The new Solid Edge Data Preparation Utility is delivered when you install Solid Edge and assists you
in analyzing and preparing your unmanaged Solid Edge documents before importing them into a
Teamcenter, Insight, or Solid Edge SP-managed environment. The new utility:
•

Combines the three previously separate tools: Analyze, Link Fix-Up, and Modify, into one tool.

•

Provides the functionality to generate reports for custom properties and reverse link information.

•

Maintains command line functionality using the program \Program Files\Solid Edge
ST9\Program\DataPrepUtility.exe along with options.
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For more information, see the help topic, Solid Edge Data Preparation Utility.
New Where Used options
You can now choose a Revision Rule as input to the Where Used command. On the Where Used
Results dialog box you can:
•

Select the Use Precise check box to display the BOM view revisions where the current document
is placed precisely.

•

Clear the Use Precise check box and select the revision rule tod isplay the BOM view revisions
where the current document is used.

For more information, see the help topic, Where Used Results dialog box.
Structure Editor - Teamcenter
Sort indented lists
Structure Editor now supports sorting in an indented list. Using the shortcut command, Sort, you can
select a column and sort the contents:
•

In ascending order, where the lowest number or beginning of the alphabet appears first in the
sorted list.

•

In descending order, where the highest number or end of the alphabet appears first in the
sorted list.

•

In alphabetic and numeric order, so that data containing alphabetical letters mixed with numbers
is sorted logically.
Example
1
1a
2
2a
2b

•

Alphabetically, where the beginning of the alphabet appears first in the sorted list.
Note
When a column has repeating values for rows, you can select additional columns for sorting
values. Shift+double-click subsequent column headers to add columns as additional
sort columns.

For more information, see the help topic, Sort multiple columns.
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Solid Edge Structure Editor standalone installation discontinued
The option to download Solid Edge Structure Editor as a standalone application is discontinued. You
now install Solid Edge and the Teamcenter Integration for Solid Edge (SEEC), and then run Structure
Editor from your Start menu.
Scroll Lock command removed
Structure Editor windows now automatically scroll in synchronization with one another. The Scroll
Lock command has been removed from the View menu.
Updated User Session information
User Session information is now easier to obtain than ever before.
•

You can log on to Teamcenter and access User Session information from the start page.

•

Once you are connected to Teamcenter, your current cache workspace is displayed.

•

You can access and change user settings any time a document is checked out to you.

For more information, see the help topic, User Session Information available in Structure Editor and
Add to Teamcenter - Interactive help.
Access to Managed page of Solid Edge Options
The Manage page of the Options dialog box is now accessible from within Add to
Teamcenter-Interactive and Structure Editor. Several new options are available to you, including
options for:
•

Teamcenter client communication system settings (TCCS)

•

Creation of Solid Edge Assembly BOM View Revisions

•

Use of Variant Rules

•

Structures that contain multiple revisions of an item

For more information, see the help topic, Manage page (Solid Edge Options dialog box).
Add to Teamcenter Interactive
Sort within indented lists
Add to Teamcenter Interactive now supports sorting within an indented list. Using the shortcut
command, Sort, you can select a column and sort the contents:
•

In ascending order, where the lowest number or beginning of the alphabet appears first in the
sorted list.

•

In descending order, where the highest number or end of the alphabet appears first in the
sorted list.
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•

In alphabetic and numeric order, so that data containing alphabetical letters mixed with numbers
is sorted logically.
Example
1
1a
2
2a
2b

•

Alphabetically, where the beginning of the alphabet appears first in the sorted list.
Note
When a column has repeating values for rows, you can select additional columns for sorting
values. Shift+double-click subsequent column headers to add columns as additional
sort columns.

For more information, see the help topic, Sort multiple columns.
Support for naming rules
You can use the custom properties Pattern_ItemID and Pattern_Revision to automatically assign
naming rules to files when an item type has a naming rule on either the Item ID or Revision, or both,
and you are importing documents into Teamcenter. Supported file types include:
•

Solid Edge document types (.par, .asm, .dft, .psm, .pwd)

•

Microsoft Word (.doc, .docx)

•

Microsoft Excel (.xls, .xlsx)

•

Image (.bmp, .tiff, .jpg, and so on).
The properties are stored in the .tmp file when you use the data preparation tools to populate
the values.

For additional information, see the help topic, Naming rules and revision naming rules.
Updated User Session information
User session information is now easier to obtain than ever before.
•

You can log in to Teamcenter and access User Session information from the Solid Edge start
page.

•

Once you are connected to Teamcenter, your current cache workspace is displayed.

•

You can access and change user settings any time a document is checked out to you.
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For more information, see the help topic, User Session Information.
Access to Managed page of Solid Edge Options
The Manage page of the Options dialog box is now accessible from within Add to
Teamcenter-Interactive and Structure Editor. Several new options are available to you, including
options for:
•

Teamcenter client communication system settings (TCCS)

•

Creation of Solid Edge Assembly BOM View Revisions

•

Use of Variant Rules

•

Structures that contain multiple revisions of an item

For more information, see the help topic, Manage page (Solid Edge Options dialog box).
Solid Edge SP
Faster delete performance
When you choose to delete data, Solid Edge SP now offers different levels of integrity checks, which
give you the flexibility to delete objects faster and allows you to quickly return to your other tasks. In
addition, several usability improvements to the Delete dialog box make the feedback from the data
integrity checks easier to read and understand.

Retaining signoff information
Solid Edge SP now preserves your workflow signoff information in its support database instead of the
workflow log list to capture this critical information more securely and reliably. The signoff information
is available to all users and is read only. Utilities to migrate existing signoff information and update
callouts are also provided.
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Pinned locations in Parts Library
With a click of a button you can now create shortcuts to up to 10 key locations inside the Parts
Library. Those programmable buttons (pinned locations) provide one-click access to the saved
locations, instead of having to re-navigate the folder structure. This helps when creating new designs
in Solid Edge SP. In addition, you can now access information about recently opened files, recent
locations, and cached files.

New one-click operation to show all assembly drawings and pdfs
Solid Edge SP Web Client now has the ability to show all (missing) drafts and pdfs using the Show
Related Drafts button
in Relation Browser. This replaces the laborious task of running
individual where-used commands with a one-click operation, and it speeds the review and approval
process.
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Improved overall Solid Edge SP usability
We improved the overall Solid Edge SP usability and efficiency, with the following additions:
•

Create a new folder from the Linked Objects dialog box.

•

Hide and display inactive carts from the Content Browser.
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•

The Preview/Properties Card now retains the last modified size.

•

Send Solid Edge SP documents as email attachments to enhance document sharing.

•

Use the Favorites folder in Solid Edge SP, Solid Edge SP Viewer, and Structure Editor.

•

Display the results of your last search, when in the Search Web Part, by pressing the Enter key.

•

Create new SESP-Documents from within Microsoft Office applications.

•

Workflow improvements:
o

Translation workflow handlers now remember the output location consistently through the
newly added preference Translated_File_Location.

o

Improved the display of workflows by making the Title box on the workflow initiation form
a mandatory entry.

o

If a workflow fails, now the workflow initiator is informed through an email notification.

Updated data preparation tools
The new Solid Edge Data Preparation Utility is delivered when you install Solid Edge and assists you
in analyzing and preparing your unmanaged Solid Edge documents before importing them into a
Teamcenter, Insight, or Solid Edge SP-managed environment. The new utility:
•

Combines the three previously separate tools: Analyze, Link Fix-Up, and Modify, into one tool.

•

Provides the functionality to generate reports for custom properties and reverse link information.

•

Maintains command line functionality using the program \Program Files\Solid Edge
ST9\Program\DataPrepUtility.exe along with options.

For more information, see the help topic, Solid Edge Data Preparation Utility.
Insight
Insight software compatibility
Solid Edge

Operating System SQL Server

ST9

Windows Server
2008 R2,
2012/2012 R2
2012/2012 R2

SharePoint
Foundation

SharePoint Server

2008 R2 or 2012

Search Server
2010 SP2*
Express 2010 SP2*

2012 or 2014

2013 SP1

2013 SP1
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This release of Insight is not supported with Microsoft Office SharePoint 2016.
SharePoint 2013 SP2 includes a known issue with Search webpart. Recommend SharePoint 2013
SP2 with hotfix.
*SharePoint 2010 is not supported on Microsoft SQL Server 2014. See Microsoft TechNet for
SharePoint and SQL Server compatibility.
Windows Server 2008 and 2008 R2 life cycle ended prior to Solid Edge ST9 release. Testing with
Windows Server 2008 R2 only.
SQL Server 2008 and 2008 R2 life cycle ends with Solid Edge ST9 release. Testing with SQL
Server 2008 R2 only.
Microsoft Product Lifecycle (EoSM):
•

1/13/2015 Windows 2008 and 2008 R2

•

7/8/2015 SQL Server 2008 and 2008 R2

•

10/13/2015 SharePoint 2010

Insight ST9 is not supported with:
•

Microsoft SharePoint 2016

•

Windows SharePoint Services 3.0

•

Microsoft Office SharePoint Server 2007

•

Microsoft SQL Server Express

•

Microsoft SQL 2005

For the latest information available, consult the individual readme files for Solid Edge and Insight
Server.
Insight standalone installation discontinued
The option to download Insight as a standalone application is discontinued. You now install Solid
Edge and the Solid Edge Insight Client, and then run Insight or Design Manager from your Start menu.
For additional information, see the Insight Implementation Guide accessible from Solid Edge
installation media or from the Solid Edge help pane.
Sort indented lists
Insight supports sorting in an indented list. Using the shortcut command, Sort, you can select a
column and sort the contents:
•

In ascending order, where the lowest number or beginning of the alphabet appears first in the
sorted list.

•

In descending order, where the highest number or end of the alphabet appears first in the
sorted list.

1-72

Fragment: Solid Edge ST9 Release Notes (topicMap)

Solid Edge ST9 Release Notes

•

In alphabetic and numeric order, so that data containing alphabetical letters mixed with numbers
is sorted logically.
Example
1
1a
2
2a
2b

•

Alphabetically, where the beginning of the alphabet appears first in the sorted list.
Note
When a column has repeating values for rows, you can select additional columns for sorting
values. Shift+double-click subsequent column headers to add columns as additional
sort columns.

For more information, see the help topic, Sort multiple columns.
Updated data preparation tools
The new Solid Edge Data Preparation Utility is delivered when you install Solid Edge and assists you
in analyzing and preparing your unmanaged Solid Edge documents before importing them into a
Teamcenter, Insight, or Solid Edge SP-managed environment. The new utility:
•

Combines the three previously separate tools: Analyze, Link Fix-Up, and Modify, into one tool.

•

Provides the functionality to generate reports for custom properties and reverse link information.

•

Maintains command line functionality using the program \Program Files\Solid Edge
ST9\Program\DataPrepUtility.exe along with options.

For more information, see the help topic, Solid Edge Data Preparation Utility.
View and Markup and Revision Manager
Where's Revision Manager?
Revision Manager has been renamed to Design Manager and has been overhauled to improve
usability and give it a modern look and feel. We also separated View and Markup from Design
Manager and then added some new functionality, such as fast search and fast where used.
For more information, see help in Design Manager and View and Markup.
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Simulation enhancements
New in Solid Edge Simulation
The following enhancements were made in Solid Edge Simulation in ST9.
Directional stress and strain result plots
Inertia relief for assembly studies in motion
Maximize quad elements in surface meshes
Suppress/Unsuppress commands for boundary conditions (loads and constraints)
New option processes radiation loads in small models
Directional stress and strain result plots
The following stress and strain plots were added to the Simulation Results environment for linear
static, modal, and buckling studies. The result plots are available based on the study type and the
mesh type (tetrahedral, surface, or mixed body).
Stress plots
These directional stress plots show the results with respect to the global coordinate system.
•
•
•
•
•
•
•

X Normal Stress
Y Normal Stress
Z Normal Stress
XY Shear Stress
YZ Shear Stress
XZ Shear Stress
Plate PrnStress Angle

For more information, see Stress component plots .
Strain plots
These directional strain plots show the results with respect to the global coordinate system.
•
•
•
•
•
•
•

X Normal Strain
Y Normal Strain
Z Normal Strain
XY Shear Strain
YZ Shear Strain
XZ Shear Strain
Plate PrnStrain Angle

For more information, see Strain component plots .
Inertia relief for assembly studies in motion
Now you can solve a linear static study of an assembly in motion without adding constraints to the
model. Previously, to solve a study you had to apply at least one constraint.
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The new option, Use Inertia Relief, is located on the Create Study dialog box, under Advanced
Options.

For more information, see Advanced Options for studies.
Maximize quad elements in surface meshes
Quadrilateral surface mesh elements produce more accurate analysis solutions than triangular
mesh elements. An option in Femap 11.22 is now available in Solid Edge Simulation to specify that
you want to create as many quadrilateral elements as possible in a surface mesh, and minimize
the number of triangular elements.
The new option, Maximize Quad Elements, is located on the Surface Mesh tab in the Mesh Options
dialog box. It is selected by default.
Suppress/Unsuppress commands for boundary conditions
Now you can evaluate the effect of individual loads and constraints on study geometry by suppressing
them. When you solve the study, the boundary conditions that are suppressed are not processed.
The Suppress command and the Unsuppress command are available on the shortcut menu for all
of the following types of boundary conditions:
•

Structural loads

•

Body loads

•

Thermal loads

•

Constraints

For more information, see Suppress individual loads to compare results.
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New option processes radiation loads in small models
An NX Nastran option is now available to solve steady state heat transfer studies with radiation
enclosure loads on models with relatively small geometry and small mesh elements. The new option,
ZTOL, is located on the Radiation Load Options dialog box.

Translator and converter enhancements
Translator and converter enhancements
These enhancements were made to translators and converters in Solid Edge ST9.
Aspect ratio now available for block labels
Custom line types supported in AutoCAD translation
Exporting JT using adaptor
Exporting to IFC (.ifc) enhanced
Import and export of simplified bodies enhanced
Translation of dimensions supported in import of AutoCAD files
Assembly overrides during export enhanced
Import and export of 3D data points now supported
Text automatically rotated in PDF
Tolerance text height override
Writing formula on export during JT translation
Parent properties written to embedded bodies during JT translation
Solid Works data migration enhanced
Aspect ratio now available for block labels
A new Aspect ratio option on the Block Label Properties dialog box specifies the aspect ratio for
the block label.
Custom line types supported in AutoCAD translation
Solid Edge custom lines are now supported in AutoCAD translation.
•

When exporting Solid Edge draft files to AutoCAD, you can use the Solid Edge to AutoCAD
Translation Wizard (Line Type Mapping) to assign a Solid Edge custom line type to a specific
AutoCAD line type. Previously, custom line types were exported to AutoCAD as continuous lines.
For more information see, Solid Edge to AutoCAD Translation Wizard (Line Type Mapping).
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•

When importing AutoCAD files to Solid Edge, you can use AutoCAD to Solid EdgeTranslation
Wizard - Step 4 of 8 to assign a AutoCAD custom line type to a specific Solid Edge line type.
For more information, see AutoCAD to Solid Edge Translation Wizard - Step 4 of 8.

Export to AutoCAD now supports property text in blocks
Solid Edge now supports property text in blocks when exporting to AutoCAD.
Many customers use the property text %{Sheet name} or %{Sheet number} within blocks to place the
blocks on the background sheet as part of the title block area. This provides an automatic numbering
scheme as they add sheets to the draft document.
Previously, when the draft document was exported to AutoCAD as paper space, the property text
%{Sheet name} or %{Sheet number} within blocks was not supported, and the sheet name and
sheet number were the same for each sheet.
Beginning in ST9 property text %{Sheet name} or %{Sheet number} used in a callout within a block
for each sheet, or in a block label for each sheet, creates a unique occurrence of the block for each
sheet that is exported.
Exporting to Industry Foundation Class (.ifc) enhanced
•

A new IFC property set option on the Export Options for IFC (.ifc) dialog box adds the IFC
property sets found in an Excel spreadsheet to the IFC file during export.

•

Two new parameters were added to the seifc.ini file:
o

Export IFC Property Set= Specifies if the IFC property sets found in the Excel file are added
to the IFC file created during export.

o

IFC Property set path= Defines the full path and name of the Excel file that contains the
property set to be included in the IFC file created during export.

For more information, see the help topic Saving to IFC.
Exporting JT using adaptor
A new translator for exporting JT files will replace the existing JT translator in ST 10. In ST9, you
can use the Use Legacy Translator and Use Beta Translator options on the Solid Edge to JT
Translation Options dialog box to specify the translator you want to use.
Note
The beta translator supports PMI except for section views, and it does not support textures.
Import and export of simplified bodies enhanced
New Part simplification and Assembly simplification options on the Solid Edge to JT Translation
Options dialog box enhance the export of Solid Edge files to JT.
For Part simplification, you can specify:
•

Use Current Configuration — Uses the current configuration to create the JT document.
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•

All Simplified — Checks each part and uses the simplified body, if available, to create the JT
document.

•

All Designed —Checks each part and uses the design body, if available, to create the JT file.

For Assembly simplification, along with the same values available with Part simplification, you
can specify:
•

Top Level Simplification — Checks the top level of the assembly and uses the simplified body, if
available, to create the JT document.
Note
These options are also available on the View and Markup tab, Options dialog box, if you
open an assembly while in View and Markup.

To support this new functionality, changes were made to parameters in the files, SePvTrn.ini,
SEECtoJT.ini, and InsightXTtoJt.ini files.
•

The ApplySimplifiedTopAsmOverride, ApplySimplifiedSubAsmOverride, and
ApplySimplifiedPartOverride parameters were removed from the .ini files.

•

Two new parameters were added to the .ini files:
o

Export Simplified parts — Specifies when to use simplified parts when exporting an assembly.
Possible values are All Designed, All Simplified, and Use Current Configuration. The
default value is Use Current Configuration.

o

Export Assembly Simplification — Specifies when to use simplified sub-assemblies. Possible
values are All Designed, All Simplified, Top Level Configuration, and Use Current
Configuration. The default value is Use Current Configuration.

Translation of dimensions supported in import of AutoCAD files
The translation of linear, angular, diametric, and radial dimensions is now supported when importing
AutoCAD dxf and dwg files to part or assembly sketch. The translation of these dimensions into
assembly sketch are identical to those dimensions translated into draft.
When dimensions are imported to sketch they are not attached to the line and arc elements. The lines
and arcs of a translated dimension are construction elements that are placed on the _Translation
layer. This layer is Off by default. You must reattach or construct new dimensions to modify the
geometry. In other words these dimensions are simply reference dimensions.
Assembly overrides during export enhanced
Enhancements have been made to assembly overrides during export to STEP and IFC.
•

Assembly features are checked for uniqueness during export. An additional subassembly is not
created when you add an assembly feature to an identical subassembly.

•

Show and hide assembly overrides are supported when exporting the assembly in its current
display configuration.
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•

Assembly color overrides are now applied to all instances of the same occurrence within the
assembly. If multiple occurrences of the same part have different assembly colors, only one
color is applied to all occurrences.

•

New Part simplification and Assembly simplification options on the Export Options for
STEP (.stp) dialog box and the Export Options for IFC (.ifc) dialog box enhance the export
of Solid Edge files to STEP or IFC.
For Part simplification, you can specify:
o

Use Current Configuration — Uses the current configuration to create the STEP or IFC
document.

o

All Simplified — Checks each part and uses the simplified body, if available, to create the
STEP or IFC document.

o

All Designed —Checks each part and uses the design body, if available, to create the
STEP or IFC file.

For Assembly simplification, along with the same values available with Part simplification,
you can specify:
o

Top Level Simplification — Checks the top level of the assembly and uses the simplified
body, if available, to create the STEP or IFC document.

o

To support this new functionality, two new parameters were added to the STEP.ini and
SEIFC.ini files:
■

Export Simplified parts — Specifies when to use simplified parts when exporting
an assembly. Possible values are All Designed, All Simplified, and Use Current
Configuration. The default value is All Designed.

■

Export Assembly Simplification — Specifies when to use simplified sub-assemblies.
Possible values are All Designed, All Simplified, Top Level Configuration, and Use
Current Configuration. The default value is All Designed.

Export mechanical symbols using AutoCAD fonts
A new Export Mechanical Symbols using AutoCAD font parameter in the Seacad.ini file specifies
when to export Solid Edge mechanical symbols using an AutoCAD font rather than the Solid Edge
symbol font. The default value is 0. Setting the value to 1, specifies to use the GDT.tff font where
possible or draw the mechanical symbol for only callouts and balloons.
Note
This parameter is under constuction for ST9, but you may use it if you find it helpful.
For more information, see Saving to AutoCAD.
Import and export of 3D points now supported
Solid Edge now supports import and export of 3D points when working with STEP and IGES
documents.
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When importing STEP documents to Solid Edge, use the Import Curves and Points option on the
Import Options for STEP (.stp) dialog box to import 3D points. When importing IGES documents to
Solid Edge, use the Wire frame and points option or the Surfaces, solids, wire frame, and points
option on the IGES Import Wizard - Geometry Types dialog box to import 3D points.
The imported 3D points become points in a single 3D sketch in Solid Edge.
When exporting Solid Edge documents that contain 3D points to STEP or IGES, use the Export
wires and points option on the Export Options for STEP (.stp) dialog box or the IGES Export
Wizard - Types dialog box.
Text automatically rotated in PDF
A new Auto rotate sheets for text readability option on the the PDF Export Options dialog box
automatically rotates the drawing sheet so the text orientations are horizontally aligned.
Tolerance text height override
A new parameter has been added to the SEACAD.ini file:
•

Import Tolerance Text height — Specifies a static tolerance text height override for text being
inported from DXF documents. The default value is 0 and any real number 0 or above is valid.

Writing formula on export during JT translation
A new Export using DocnameFormula parameter specifies whether to use the file name or the
Document Name Formula when exporting to JT. Setting Export using DocnameFormula=0 specifies
that you want to use the file name. Setting Export using DocnameFormula=1 specifies that you
want to use the Document Name Formula.
The parameter is available in the following files:
•

SePvTrn.ini

•

SE2VM.ini
Note
The parameter is automatically enabled when you use the Open in View and Markup
command in Solid Edge. You need to enable the parameter through the ini file if you want to
use the functionality when exporting to JT.

Parent properties written to embedded bodies during JT translation
In a Teamcenter-managed environment, the property values for the parent object in an assembly is
now written to the embedded bodies within the assembly when translated to JT.
SolidWorks data migration enhanced
The SolidWorks data migration command has been enhanced to include the migration of associative
drawings views. Updating the migrated Solid Edge part and assembly files now updates the Solid
Edge draft file. During the migration process a link is established between the resulting Solid Edge
parts and assembly files and the migrated Solid Edge drawing file. The Solid Edge drawing views are
created based on the SolidWorks drawing view location, type, and scale.
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The following applies when migrating SolidWork files:
•

All drawing view types created in SolidWorks are supported.

•

Cutting plane lines, auxiliary view plane lines, and detail envelopes are supported.

•

Dimensions migrated from SolidWorks are bound to Solid Edge drawing view geometry.

•

Center marks and center lines are associative to the Solid Edge drawing views.

•

Hatch and solid fills are migrated maintaining their associativity to the Solid Edge drawing view.

•

View shading is maintained as part of this drawing view creation process.

•

Multi-sheet drawings are supported through this migration process.
Note
Annotations, such as balloons and callouts, do not migrate as Solid Edge annotations, but
migrate as blocks.

Operating system requirements and information
Solid Edge ST9 has been certified to run on the following:
•

Windows 7 Enterprise, Ultimate or Professional (64-bit only) with Service Pack 1

•

Windows 8 or 8.1 Enterprise or Professional (64-bit only)

•

Windows 10 Enterprise or Professional version 1511 or later (64-bit)

•

Internet Explorer 11
Internet Explorer is not required to be the default browser.
Note
•

Solid Edge ST9 is 64-bit only. Solid Edge ST6 was the last release of 32-bit Solid Edge.

•

Windows 8 Home, Windows 10 Home, and Windows RT are not supported.

•

Solid Edge stops certifying new releases against an operating system shortly after
Microsoft drops mainstream support for it. Solid Edge ST9 will not install on Windows
Vista or Windows XP. Microsoft dropped mainstream support for Windows 7 in January
2015. Solid Edge ST9 continues to install on Windows 7, however, if there is a Windows
7 specific problem, we cannot guarantee that a fix can be provided if support is required
from Microsoft.

•

Solid Edge ST10 will be the last release to support Windows 7.

•

Solid Edge does not support the new Windows 10 browser, Microsoft Edge.
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Hardware system requirements
Insight hardware and software requirements follow the recommendations for Solid Edge. Be sure to
consult the Solid Edge Readme.htm for additional information.
Recommended system configuration
•

64-bit (x64) processor

•

Windows 7 operating systems

•

At least 8 GB RAM

•

True Color (32-bit) or 16 million colors (24-bit)

•

Screen Resolution: 1280 x 1024 (or higher, following the manufacturer's recommendations)

Minimum system configuration
•

64-bit (x64) processor

•

Any of the supported operating systems

•

At least 2GB RAM

•
•

65K colors
Screen Resolution: 1280 x 1024 (or higher, following the manufacturer's recommendations)

Display system requirements and information
Solid Edge runs on graphics drivers that support Windows 7, Windows 8.1, or Windows 10. Contact
your graphics driver manufacturer to determine whether their graphics adapter/driver support these
operating systems.
For optimal performance, use a professional graphics card designed for CAD applications. For
information about cards used in testing Solid Edge and results, see the Hardware and Software
Certifications web site at
http://www.plm.automation.siemens.com/en_us/support/gtac/certifications.shtml.
Note
At least a 256MB graphic card is recommended when working with large assemblies or
complex parts.
Running with extremely high screen resolution and color depth increases the memory requirements
on the system and may result in apparent performance degradation. If experienced, reconfigure the
display system to the recommended resolution and color depth for improved performance.
When running Solid Edge, if you experience an abnormally high abort rate, parts disappearing, or other
graphic anomalies you may not be using the appropriate graphics driver. For details, see Certification
page of the Support web site: http://support.industrysoftware.automation.siemens.com/gtac.shtml.
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Also, setting Display Fonts to Large Fonts or Extra Large Fonts (larger than 96 DPI) may cause
some Solid Edge user interface items to not display as intended. To resolve these issues, use
Normal Fonts (96 DPI).
A wide-screen ribbon layout is used by Solid Edge. This ribbon layout is optimal for horizontal screen
resolutions set to 1920 or above. Solid Edge automatically detects your resolution and sets the ribbon
layout to wide-screen starting at horizontal resolutions 1600 and above. Some groups collapse on the
right side of the ribbon with resolutions between 1600 and 1920.

System Resource Requirements and Information
Earlier versions of Solid Edge were enhanced to access the extended address space that is available
on Windows. All running processes, including the Operating System process, share 4 GB of
addressable memory available, regardless of the amount of physical RAM. Normally, the operating
system reserves 2 GB of space and leaves 2 GB for applications. Running 32-bit operating systems
with the /3GB switch added, reserves only 1 GB for the operating system, and leaves 3 GB for
applications. This allows you to work with larger datasets without running out of addressable space.
On Windows 7 with administrator privileges, you can run the following command from the command
line to enable /3GB switch:
BCDEDIT /Set IncreaseUserVa 3072
This command tells you what options are part of the OSLOADER family:
bcdedit /? types osloader
To reset the value, use:
bcdedit /deletevalue IncreaseUserVa
The 64-bit Solid Edge supports up to 128 GB of physical RAM and 16 terabytes of virtual memory,
enabling applications to work with larger data sets. The 64-bit version of Solid Edge requires 64-bit
Windows operating systems loaded on Intel EM64T or AMD64 processors.
Page file size should be the maximum size possible. In general, the page file size should be at least
twice the amount of memory in the machine, plus the size of files you will use.
Processor Support
Component software delivered with Solid Edge, such as Parasolid and D-Cubed, started phasing out
processors not supporting Intel's SSE2 (Streaming SIMD Extensions 2) instruction set. In 2009, these
components will only support processors with SSE2.
SSE2 is one of the Intel SIMD (Single Instruction, Multiple Data) processor supplementary instruction
sets first introduced by Intel with the initial version of the Pentium 4 in 2001. AMD added support for
SSE2 with the introduction of their Opteron and Athlon 64 ranges of AMD64 64-bit CPUs in 2003.
Here is a list of common processors that do not support the SSE2 instruction set:
•

AMD CPUs prior to Athlon 64

•

Intel CPUs prior to Pentium 4
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Solid Edge only supports processors that include the SSE2 instruction set. The Solid Edge installation
checks for the presence of such a processor. If this processor does not exist, installation stops and
displays a message explaining this dependency.

Temporary File Space
Solid Edge uses temporary file space to save files and to store memory mapped display files. Using
temporary file space when saving files helps significantly reduce the size of the resulting file on
the destination file system.
You should ensure that you have twice as much free temporary file space as the size of the largest
file being saved. The file size includes the size of the assembly, the size of the subassemblies that
are being used, and the size of the part files.
Running Solid Edge creates temporary memory mapped files that are used to support the display
system. When you open assembly and part files, memory mapped files are created in the temp
directory on the hard drive only while the files are displayed. The memory mapped files are deleted
after exiting the Solid Edge file. If the system runs short on temporary space on the primary drive, you
can set an environment variable called JRENDER_TEMP and define another folder on a drive with
sufficient space and then Solid Edge creates the memory mapped files in the new location.
Running Solid Edge creates a file named DCCACHE.tmp in the system temp folder. This file is a
cache of the file icons displayed on the dialogs for browsing, opening, and saving files.
If Solid Edge files are not properly associated with the product, try deleting this file and restarting
the product.
It is good practice to periodically delete files in temporary folders so your system is not using
unnecessary disk space.
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